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1. Der spektroskopische Be-Doppelstern  Tau 
  

 

 Tau ist ein interessanter spektroskopischer Doppelstern in 

rund 400 Lj. Entfernung. Seine hohe scheinbare Helligkeit von 

3 mag. prädestiniert ihn für die Spektroskopie auch mit 

kleineren Teleskopen. Sinnvolle spektroskopische 

Auswertungen erfordern jedoch ein spektrales Auflösungs-

vermögen von R > 4000, welches unter anderem der DADOS 

mit den Gittern 900 L/mm und 1200 L/mm ermöglicht. 

Die Literaturdaten zum Stern sind uneinheitlich. Der 

Spektraltyp des ca. 15500K heißen Sterns wird unterschiedlich 

angegeben: B1 IVe shell (SIMBAD), B2 IVe, B2 IIIpe. Sicher ist, 

dass er von einer leuchtenden Wasserstoffscheibe umgeben 

ist.  

Die Rotationsgeschwindigkeit des 

einzig in Erscheinung tretenden 

Hauptsterns beträgt 320-330 km/s1. 

Die Fliehkräfte aufgrund der hohen 

Rotations-geschwindigkeit sind die 

Ursache der etwa 100 

Sonnendurchmesser großen äquato-

rialen Gasscheibe um den Hauptstern. Sie leuchtet in Form 

eines sich periodisch verändernden Doppelpeakprofils, 

welches durch eine V- und eine R-Komponente geprägt ist.  

 
1 Quelle: Ernst Pollmann 
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BeSS-Datenbank, http://basebe.obspm.fr/basebe/ 

 

 

 

 

 

 

 

 

 

Doch ganz so einfach ist das 

Modell nicht. Mit einer 

Periode von 1471 ± 15 Tagen 

präzediert eine Wasserstoff-

scheibe, die eine lokale 

Verdichtung aufweist. Eine 

weitere Zyklusperiode 

beträgt 69 Tage. 

Schließlich ist eine weitere 

Periode von 442 +/-5 Tagen 

ist in der Lage der Zentralen 

Absorptionseinsenkung zu 

finden2.  

 

Animation zum Disknodding:  

 
2 Quelle: Ernst Pollmann, Unterlagen zum Herbstkurs Sternspektroskopie 2017 am CFG Wuppertal 

DADOS 1200 lines/mm 

SBIG ST-8300M, 1 x 1 
Binning 

Ne I 
Ne I Ne I 

 intensity 
in the red (R) 

  V       
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Multi-epoch Near-Infrared Interferometry of the Spatially Resolved Disk Around the Be Star ζ Tau (Schaefer et 
al., http://arxiv.org/abs/1009.5425) und Ernst Pollmann 
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1.2 Festlegung der Messgrößen 
 

Im von Ernst Pollmann moderierten Langzeit Monitoring sind folgende Messgrößen bei der H-Linie zu 

ermitteln:  

➢ H-Äquivalentbreite EW: 6520Å-6600Å 

➢ Intensität des H V-Peaks 

➢ Intensität des H R-Peaks 

➢ V/R-Verhältnis der H−Linie 

➢ Tiefe der zentralen Absorption CA 

➢ Heliozentrische Radialgeschwindigkeit HRV des H-Absorptionsminimums (CA, Central Absorption) 

 

  

Ne I 6506.5277Å 

Ne I 6532.8824Å Ne I 6598.9528Å 

 intensity in the red 
(R) and  

  V      R 

Zentrale 
Absorption (CA) 

Zeta Tau 2014-03-10, JD 2456727.386 
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2. Die Kalibriereinheit 
Diese einfach zu realisierende Selbstbau-Kalibriereinheit beruht auf dem TSFLIP3 und zeichnet sich dadurch 

aus, dass unterschiedliche Lichtquellen, wie hier die helle, sehr empfehlenswerte Baader Neon-Kalibrierlampe 

(#2458590) eingeblendet werden können. Man schraubt die 2-Zoll Steckhülse TST2-2 auf den Guiderausgang 

des TSFLIP und fasst die Lichtquelle mit der Hülse TSVF230.  

Dann setzt man die Guidereinheit um 

180° gedreht wieder ein, so dass das 

Licht der Kalibrierlampe in Richtung 

Spektrografeneingang umgelenkt 

wird. Zum Ein- und Ausblenden wird 

die Guiderhülse ganz einfach hinein- 

bzw. herausgeschoben. 

Bemerkung: 

Der Autor dankt Dr. Dieter Hess für 

den Hinweis auf die Eignung des 

TSFLIP für Kalibrierzwecke mit dem 

DADOS. 

 

 

 
3 https://www.teleskop-express.de/shop/product_info.php/info/p5190_TS-Optics-2--Flip-Mirror-System---

Off-Axis-Guider---kurzbauend.html 
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3.  Tau Summenspektrum und Neon-Referenzspektrum 
 

Aufnahmedaten: 

 

DADOS, Gitter 1200 L/mm, mittlerer Spalt: 25m  

SBIG ST-8300M (KAF-8300M) im 1x1-Binning, Pixelgröße 5.4m, CCD-Temperatur: -20°C 

Celestron 14 @f/8 auf 10Micron GM2000HPS 

Aufnahmedatum: 17.2.2018, Mitte der Aufnahme: 21:56:59 UT (JD 2458167.414572),  

Belichtung: 8x120s 

 

Die Aufnahmen wurden in dieser Reihenfolge (Aufnahmebeginn) gewonnen  

 

21.42 UT: Neon Spektrum, 10s 

21.47 UT: zeta Tau, 120s 

21.49 UT: zeta Tau, 120s 

21.51 UT: zeta Tau, 120s 

21.53 UT: zeta Tau, 120s 

21.56 UT: zeta Tau, 120s 

21.58 UT: zeta Tau, 120s 

22.00 UT: zeta Tau, 120s 

22.02 UT: zeta Tau, 120s 

22.04 UT: Neon Spektrum, 10s 

22.10 UT: Dark, 120s 

22.12 UT: Dark, 120s 

22.14 UT: Dark, 120s 

22.16 UT: Dark, 120s 

22.18 UT: Dark, 120s 

 

Vorbereitung der Rohdaten in MaxIm DL 

 

Schritt 1: Master-Darkframe (Median) aus 

5x120s Einzeldarks erzeugen. 

 

Schritt 2: Beide Neonspektren mitteln 

(Average): Neon.fit 

 

Schritt 3: Von jedem zeta-Tau-Spektrum wird  

das Masterdark subtrahiert. 

 

Schritt 4: Stacking der korrigierten Einzelspektren von zeta Tau (Sum, IEEE Floating Point): zeta Tau 8x120s.fit 

 

Referenzspektren und Objektspektren müssen zeitlich nah beieinander aufgenommen werden. Grund: Der 

Spektrograf kann sich thermisch ausdehnen oder zusammenziehen, wenn sich die Außentemperatur ändert. 

Deshalb lässt man den DADOS und das Teleskop zunächst eine halbe Stunde auskühlen, bevor man beginnt. 

Zuerst wird ein Referenzspektrum aufgenommen, dann eine Serie von Objektspektren und zum Schluss wieder 

ein Referenzspektrum. Ein Flatfield wurde in diesem Fall nicht aufgenommen. Außerdem sollte der 

Spektralfaden bereits möglichst exakt horizontal orientiert sein, blaues Ende links, rotes rechts. 

H 
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4. BASS starten 
 

Dieses Tutorial setzt voraus, dass das Objektspektrum zeta Tau 8x120s.fit und das Neon-Referenzspektrum 

Neon.fit im Ordner C:/astrobodger/zeta Tau 2018-02-17/…. im Format FIT vorliegen.  

Start der aktuellen Version BASSProject.exe im Ordner C:/astroboger 

Das leere Arbeitsfenster eines neuen Projekts in der BASS 64-Bit-Version: 

 

BASS arbeitet mit sogenannten „Projekten“, bei denen alle verwendeten 2D-Rohspektren, Ergebnisse und 

Beschriftungen gespeichert werden an einem festen Speicherort, C:/astrobodger. Projekte werden im Format 

.bass abgespeichert. BASS meldet sich, wenn Teile des Projekts (neue oder geänderte Spektralprofile) noch 

nicht gespeichert wurden und fordert dann dazu auf. Änderungen an vorhandenen oder neu erzeugte 

Spektralprofile werden im Format .fit (bzw. .dat) abgespeichert. Das FITS-Format ist umfangreicher als das 

DAT-Format, weil zusätzlich zu den Datenzeilen x,y auch alle wichtigen sonstigen Informationen gespeichert 

werden: Datum, Uhrzeit, Belichtungszeit, Aufnahmeort, etc.  

Hinweis: Der Begriff „2D“ bedeutet in der Spektroskopie, dass es sich um ein Foto des Spektrums handelt, so 

wie man es am Teleskop aufnimmt. „1D“ ist der aus dem Foto erzeugte Spektralprofil, welches nur ein 

Datensatz mit zwei Spalten ist: x =Position entlang des Sensors, y=Intensität in y-Richtung aufsummiert.  

http://www.schuelerlabor-astronomie.de/
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4.1. Spektren in BASS öffnen  

➔  Open Image Files    

➔ Neon.fit und zeta Tau 8x120s.fit  

 

 

 

 

 

 

 

 

 

Grün: unkalibriertes zeta-Tau-Spektrum. Blau: Neon-Referenzspektrum 

Erläuterung: Die x-Achse („Pixels uncalibrated“) entspricht der Pixelposition in horizontaler x-Richtung auf dem 

Foto. Dieser Pixelwert muss in einen Wert für die Wellenlänge  (Lambda) umgerechnet werden. Die 

Ermittlung des funktionalen Zusammenhangs zwischen Pixelposition (x) und Wellenlänge () in Form eines 

Polynoms höheren Grades =f(x) bezeichnet man als Wellenlängenkalibrierung. 

Die y-Achse („Flux“) gibt die Intensität an einer bestimmten Pixelposition im 1D-Spektralprofil an. Diese 

Intensitätskurve wird in diesem Tutorial kalibriert: Beseitigung des Pseudokontinuums (Normierung auf „1“).  
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➔   Speichern des Projekts unter dem Namen C:/astrobodger/zeta Tau 2018-02-17/zeta Tau 

2018-02-17.bass 

 

 

 

 

 

 

 

 

 

➔ Prüfen, ob Projekt korrekt gespeichert ist: New Projekt  ➔Open Project   

 

Hinweis: Das Neon-Spektrum muss an Position 1 stehen. Falls dies nicht der Fall ist, jetzt Positionen 

tauschen:  

 

➔ #02 aktivieren ➔ Rechte Maustaste  ➔ Sequence ➔ 01 

 

4.2 Voreinstellungen vornehmen 

➔   Project Chart Settings: Hier alle Daten eingeben.  

➔ Main Title und Sub Title speichern 
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Chart width: CFG Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 

➔   Speichern des Projekts unter dem Namen C:/astrobodger/zeta Tau 2018-02-17/zeta Tau 

2018-02-17.bass 
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5.  Sternspektrum und Referenzspektrum horizontal ausrichten. 
 

Zuerst werden die Captions (Namen) der Scans geändert 

 

➔ Neon.fit  umbenennen in Neon-Referenz  

➔ zeta tau 8x120s.fit  umbenennen zeta tau in VV Cep  

 

Spektren horizontal ausrichten 

 

➔ Image Strip View  

➔ Raw Image 50%  

 

➔ Spektrum #02 (zeta Tau) aktivieren 

 

➔ Image ➔ Rotate/Tilt correction 

 

➔ Select Region, Tilt Image, Emission, Apply to all 

open images wählen. 
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➔ Dann mit der Maus um das Spektrum einen Rahmen aufziehen: 

 

➔ Apply ➔ Close 

Nun sind beide Spektren gleichermaßen um einen Winkel von 0.63° 

horizontal ausgerichtet.  

Eine Smile/Slant-Korrektur muss hier nicht vorgenommen werden, da im 

genutzten Spektralbereich des Sternspektrums die Linien gerade sind und 

senkrecht auf dem Spektrum stehen. 

➔   Abspeichern der beiden gedrehten Spektren: Save the selected image strip (selbe Namen)  

  

➔  Speichern des Projekts:  Unter dem selben Namen 
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6. Auswahl des Scanbereichs für Spektrum und Himmelshintergrund 
➔ Sternspektrum #02 auswählen 

➔ Image Strip View: 100% 

➔ Selection ➔ Region Selection Tool  

 

 

 

 

 

 

Es erscheint das Menüfenster Region Selection Tool.  

➔ Active Binned Region (Sternspektrum definieren) 

➔ Ziehe nun einen Rahmen innerhalb des Spektrums auf 

➔ Update 

 

 

 

 

 

 

 

 

 

➔ Verändere die Werte für Y Start und Y End, bis der Rahmen das Spektrum in nahezu voller Höhe 

umfasst. Die Breite wird automatisch angepasst. 

 

➔ Update ➔   Bildschirm-Refresh ➔ Close 

 

Hinweis: Unklar ist, inwieweit die Statistik der aktiven Binning-Zone hinsichtlich der Erzielung eines optimalen 

SNR innerhalb des Scanbereichs verwendet werden kann. 

 

 

(Rahmen aufziehen) 
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Nun werden die beiden Regionen für den Himmelshintergrund oben/unten definiert: 

Manuelle Festlegung der beiden Himmelshintergrundbereiche oben/unten: 

➔ Substraction Region 1 (für Himmel „oben“, also oberhalb des Sternspektrums) 

➔ Rahmen aufziehen für Himmel „oben“ 

 

➔ Update. Der Rahmen wird automatisch über die ganze Breite aufgezogen. 

 

➔ Substraction Region 2 (Himmel „unten“, also unterhalb des Sternspektrums) 

➔ Rahmen aufziehen für Himmel „unten“ 
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       Und das ist das Ergebnis der Festlegung der Bereiche:  

 
➔ Update ➔ Close 

➔   Bildschirm-Refresh nicht vergessen!! 

Nun wird NUR die „Active Binning Zone“, also der Bereich des Sternspektrums VV Ceps, der gescannt wird, auf 

das Referenzspektrum übertragen: 

➔ Mit linker Maustaste in das Spektrum 01: Neon-Referenz aktivieren 

➔ Mit rechter Maustaste in das Spektrum 01: Neon-Referenz klicken 

➔ Copy Active Binned Region from 

➔ 02: zeta Tau 2018-02-17 

 

Ergebnis: Es sind alle benötigten Bereiche in beiden Spektren definiert:  
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➔   Speichern des Projekts 

Das grüne Spektrum von zeta Tau ist das Resultat folgender Operation: 

Intensität des Spektrums von zeta Tau  = Intensität der Active Binning-Zone – Intensität (Himmel oben + Himmel unten)/2  

  

Himmel oben 

Referenzspektrum 

Spektrum Capella 
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7. Einzelne Spektralbereiche genauer betrachten  
 

➔ Beispiel: H-Linie 

➔ Ziehe mit der linken Maustaste einen Bereich von ca. 2100px bis 2800px auf 

➔   Crop X-Axis Range 

 

  

 

 

 

 

 

 

 

 

➔ Apply 

 

➔ Zurück zur Gesamtansicht 

 

➔  Crop X-Axis Range  

 

➔ Turn off cropping ➔ Apply ➔ Ok 

 

➔ Projekt speichern 
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8. Wellenlängenkalibrierung 

8.1 Das Neon-Referenzspektrum 
Die Wellenlängendatei befindet sich im Ordner c:/astrobodger/Reference/Neon.dat (NEU!)4 

 

  

 
4 http://www.astrosurf.com/buil/us/spe2/hresol4.htm 
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8.2 Wellenlängenkalibrierung des Spektrums des Referenzspektrums 
Hinweis: Die Kalibrierung wird hier nicht über das gesamte Spektrum durchgeführt, sondern nur im Bereich 

um H. Dies sind die hier verwendeten acht Referenzlinien mit dem vorweggenommenen Ergebnis der 

Kalibrierung. In die Nähe dieses Ergebnisses wollen wir gelangen. 
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➔  Enter Line Calibration Mode                             

➔ Erste Referenzline 6334.4278Å eng eingrenzen 

➔ Element filter: Neon.dat auswählen 
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➔ Add Another Point 

➔  Referenzline eng eingrenzen: 6382.9917Å 

 

➔ Add Another Point 

➔ Referenzline eng eingrenzen: 6402.246Å 
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➔ Add Another Point 

➔ Referenzline eng eingrenzen: 6506.5281Å 

➔ Suggest bietet an: …… Die korrekte Wellenlänge 6506.5281Å wird angeboten 

 

➔ Add Another Point 

➔ Referenzline eng eingrenzen: 6532.882Å 

➔ Suggest bietet an: 6532.882Å 

 

➔ Calibration fit umstellen auf 2 Quadratic (Polynom zweiten Grades). Restfehler nun: 0.02122Å 
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➔ Add Another Point 

➔ Referenzline eng eingrenzen: 6598.9529Å 

➔ Suggest bietet an: 6598.9529Å 

 

 

 

 

 

 

 

 

 

 

➔ Calibration fit umstellen auf 3 Cubic (Polynom dritten Grades). Restfehler nun: 0.018Å  

 

➔ Add Another Point 

➔ Referenzline eng eingrenzen: 6678.276Å 

➔ Suggest bietet an: 6678.276Å 
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➔ Add Another Point 

➔ Referenzline eng eingrenzen: 6717.043Å 

➔ Suggest bietet an: 6717.043Å 

 

➔ Vorläufiger Restfehler nun: 0.016Å  

Es ist nicht sinnvoll, hier einen höheren 

Polynomgrad als 3 oder maximal 4 zu 

wählen. Der Dispersionsverlauf des 

Spektrografen entspricht einer flachen 

Kurve, die sich nur gerinfügig von einer 

linearen Funktion unterscheidet.  

Wir können probieren, die Genauigkeit durch 

Deaktivieren bzw. Löschen der 

ungenauesten der 8 Linien zu erhöhen. 

Betrachten wir, wie sich die Deaktivierung 

auf den Bereich um die H-Linie herum 

auswirkt. 

Da wir später den Bereich der H-Linie 

ausmessen wollen, interessiert uns dieser 

Bereich besonders. 
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Hinweis: Seit Version 1.9.8b4 kann man „ungenaue“ Stützpunkte deaktivieren/aktivieren und das Polynom 

jeweils neu berechnen lassen: Man setzt ein Minuszeichen vor die Pixelposition einer Linie, die nicht 

berücksichtigt werden soll. Nun klickt man in eine andere Zeile, was die Neuberechnung auslöst. Mit Löschen 

des Minuszeichens kann die Linie wieder aktiviert werden.   

Man kann nun solange Linien aktivieren und deaktivieren, bis eine befriedigende Genauigkeit entweder im 

Zielbereich H oder über den gesamten Bereich erreicht ist.  

Allerdings sollte man immer das Ziel der Maßnahme im Auge behalten. Wenn man sich auf einen Bereich 

konzentriert, sollte man in dessen Nähe mehr Referenzlinien wählen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Die Wellenlängenkalibrierung verbessert sich erheblich auf RMS=0.00264Å verbessert.   

➔ Finish 

➔ Speichern 
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8.3 Übertragung der Wellenlängenkalibrierung auf das Spektrum von zeta Tau 
 

➔ 02: zeta tau 2018-02-17 anwählen  

➔  Profile properties 02: zeta tau 2018-02-17 

➔ Use Calibration from first profile 

➔ Copy 

➔ Ok 

➔ Apply 

➔ Ok  

➔   jeweils 

speichern 

 

➔ Image Strip View umstellen auf Synth Color stretched (synthetisches Sternspektrum) 

➔  Speichern des Projekts unter dem selben Namen zeta tau 2018-02-17.bass 

 

➔ Show/Hide Calibration Points: Schaltet die Anzeige der Kalibrierpunkte ein und aus! 

 

Ausblenden des Referenzspektrums #01 

 

➔ Rechte Maustaste auf Spektrum #01:  

➔ Linke Maustaste auf Spektrum 02: zeta Tau mit der Maus aktivieren: 

➔ Falls gewünscht, Farbe ändern: 
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9. Normierung der relativen Intensität des Spektrums 
 

Der Intensitätsverlauf des wellenlängenkalibrierten Spektrums stellt nicht den wahren Kontinuumsverlauf dar. 

Dieser wird durch verschiedene Faktoren verfälscht. Dazu zählt die Instrumentenfunktion („Response“) von 

Teleskop, Spektrograf und Kamera, sowie Absorption und Streuung an interstellarem Staub und Molekülen in 

der Erdatmosphäre. Zusammengefasst spricht man von einem Pseudokontinuum.  

Auf zwei verschiedene Arten können diese Einflüsse beseitigt werden: Normierung auf „1“ oder 

Flusskalibrierung. 

9.1 Pseudokontinuum entfernen 
Unter der Normierung eines Spektrums versteht man die Eliminierung des pseudokontinuierlichen Anteils im 

Spektrum (Continuum Removal), so dass nur noch die Spektrallinien im Spektrum verbleiben.  

Subtraktion des Kontinuums: Hat den Nachteil, dass bei einer Subtraktion die relativen Intensitäten der 

Spektrallinien zueinander nicht stimmen. Wird in der Regel nicht angewendet. 

Division durch das Kontinuum: Die relativen Intensitäten bleiben erhalten, das Divisionsergebnis ergibt im 

Spektrum im Idealfall einen exakt horizontalen Verlauf, dessen Intensität den Wert „1“ aufweist. Deshalb 

spricht man auch von der Normierung auf „1“. Dies wird im Folgenden beschrieben. 

1. Durchführung einer Normierung des gesamten Spektrums  

➔ Spektrum 02: zeta Tau an Position 1 bringen 

 

➔ Hide Profile from chart 01: Neon-Referenz  

 

➔ Spektrum 01: zeta Tau aktivieren 

 

➔  Continuum and Response Shaper  

anwenden auf 01:zeta Tau 

 

➔ Free Draw wählen 

 

➔ Kästchen setzen per Doppelklick entlang des Kontinuums.  

 

➔ Refresh aktualisiert das Bild. Kästchen löschen mit mittlerer 

Maustaste. Spektrallinien großzügig überbrücken, ohne die Flügel 

der Linien zu kappen. Die so definierte orangene Kurve ist das 

sogenannte Pseudokontinuum, meist auch als Response 

bezeichnet.  
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➔ Save as Continuum Removal for: 02 

zeta Tau 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Normierung direkt anwenden: Abfrage mit Ok beantworten 
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Ergebnis: Das (vorläufig) normierte Spektrum. 

 

➔ Falls das durchschnittliche Kontinuum in Bereichen NICHT auf einer horizontalen Linie liegt, kann das 

Pseudokontinuum nochmals editiert werden. 

 

➔      Response ➔ Edit 

 

 

 

 

 

 

 

 

 

➔ Target Profile: 01 zeta Tau 

➔  

➔ Free Draw 

 

➔ Neue Kästchen können gesetzt und/oder alte entfernt 

werden. Löschen durch Drücken auf das Mausrad! 

 

➔ Save  
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➔ Ok 

 

➔  Projekt zwischendurch immer mal speichern:   

C:\astrobodger\zeta Tau 2018-02-17\zeta Tau 2018-02-17.bass 

 

 

 

Ansicht Vorher/Nachher: Wie sieht das Profil mit bzw. ohne Kontinuumsentfernung aus?  

 

➔  Profile Properties  

 

➔ Response 

 

➔ Continuum Removal  

No Response Correction 

 

➔ Jeweils Apply 
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9.2 Normierung auf „1“ 
„Normierung auf 1“ bedeutet, dass das Kontinuum auf den Wert 1 festgelegt wird.  

Zunächst sicherstellen, dass das Spektrum von zeta Tau an Position 1 steht: 01: zeta Tau 2018-02-17  

➔ Falls nicht, mit rechter Maustaste in das zeta-Tau-Spektrum klicken 

➔ Sequence 

➔ #01 auswählen 

 

Falls links und rechts unerwünschte Bereiche sind, diese nun ausgrenzen. Ein vollständiges Entfernen aus 

dem Datensatz ist in dieser späten Phase aber nicht mehr möglich: 

 

➔ Mit der linken Maustaste das Spektrum wie gewünscht eingrenzen 

➔  Crop X-Axis Range 

➔ Wellenlängenbereich eingrenzen mit der Maus. 

➔ Apply 

➔   File ➔ Save Project File 

 

Normierung auf „1“ durchführen: 

 

➔ Image  

➔ Normalize Flux Scale 

➔ Im Spektrum einen Bereich definieren, der den Wert 1 erreichen soll. Hier bei ca. 6000Å-6100Å 

➔ Falls unzufrieden mit der Lage der „1“-Linie, neue Start- oder Endwerte eingeben und Apply drücken. 

➔ Falls zufrieden: Close 

 

Hinweis: Die Normierung 

auf „1“ ist ein höchst 

subjektiver Vorgang, der 

von jedem Bearbeiter mit 

einem anderen Ergebnis 

durchgeführt und 

beurteilt wird. Dies kann 

später zu einer Streuung 

der Messwerte führen. 
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9.3 Manuelle Skalierung der Y-Achse (Flux, relative Intensität) 
Die manuelle Skalierung der Y-Achse (Flux) des Spektrums von zeta Tau beträgt in diesem Beispiel 0 bis 2:  

 

Skalierung der Y-Achse 

 

➔   Profile Properties 

 

➔   Save Property Settings 

 

➔ Apply 

 

➔ Ok 

 

 

 

 

 

 

Ergebnis: Das auf „1“ normierte Sonnenspektrum, in der Intensität von 0 bis 2 skaliert. Das Referenzspektrum 

bleibt ausgeblendet. 

 

➔   File ➔ Save Project File 
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10. Beschriftung des normierten Spektrums  
 

➔ H-Ruhewellenlänge 

einzeichnen 

 

 

 

 

 

 

 

 

➔  Label the chart  

 

➔ Manage Labels 

 

➔ Speichern 

 

➔  Projekt speichern 

 

 

 

 

 

 

 

➔ Edit Label 

 

➔ Speichern 

 

➔  Projekt speichern 
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  ➔   Speichern des Projekts mit allen Skalierungen und Beschriftungen:  zeta Tau 2018-02-17.bass  

11. Notizen erstellen und einblenden 
 

➔  Chart Settings  

 

 

 

 

12. Speichern eines 1D-Profils (Wellenlänge, Intensität) im FITS-Format 
 

➔  Speichern des Spektralprofils (_1D), um es bsp. in VisualSpec oder MIDAS zu verarbeiten:   

 zeta Tau 8x120s-1D.fit 
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13. Datenerfassung im 1D-Profil für die BeSS-Datenbank 

13.1  Zeta Tau in der BeSS-Datenbank 
Zeta Tau ist ein klassischer Be-Stern, dessen Spektren mit anderen in der BeSS-Datenbank verglichen oder 

zugeführt werden können5. Gibt man im Abfrage-Fenster zeta Tau ein, werden Anfang März 2018 insgesamt 

2548 Spektren angeboten:  

 

Spektren, die im Vergleichszeitraum mit höherer spektraler Auflösung (LHIRES III) aufgenommen wurden: 

 

 

 
5 http://basebe.obspm.fr/basebe/ 
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13.2  Öffnen des 1D-Profils 
 

➔    

 

 

 

 

 

 

 

13.3 BeSS-Settings 
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6786 (Messung später) 

285 (?)  
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Dieses heliozentrisch korrigierte 1D-Profil kann nun mit Validate BeSS geprüft werden 

 

 

 

 

 

 

Export des RV-unkorrigierten 1D-Spektrums 

 

Export des RV-korrigierten 1D-Spektrums  
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13.4 Der FITS-Header 
Hier der von BASS bisher geschriebene FITS-Header: 

➔ Image ➔ FITS Header … 
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14. Erfassung der Messgrößen EW, V, R, CA, HRV-CA 
Im von Ernst Pollmann6 moderierten Langzeit Monitoring des Sterns zeta Tau sind folgende Messgrößen bei 

der H-Linie zu ermitteln:  

 

➢ H-Äquivalentbreite EW: 6520Å-6600Å 

➢ Intensität des H V-Peaks 

➢ Intensität des H R-Peaks 

➢ V/R-Verhältnis der H−Linie 

➢ Tiefe der zentralen Absorption (CA) der H-Linie 

➢ Heliozentrische Radialgeschwindigkeit HRV des H-Absorptionsminimums (HRV-CA) 

 

➔  Öffnen des heliozentrisch korrigierten Spektrums 

 

 

 

 

 

 

 

 

 

➔  Crop X-Axis Range    ➔   Profile Properties 

 

 

 

 

 

 

 

 

 

 

 
6 http://www.astrospectroscopy.de/projects.html 
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➔ Measurements and 

Elements  

 

➔ Element File: LambdaData.dat 

➔ Measurement Options: 

Equivalent Width 

 

➔ EW=-10.49Å 

➔ V=1.938 

➔ R= 1.779 

➔ CA=1.186 

➔ V/R=1.089 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

R=1.779 

 

V=1.938 

 

CA=1.186 

HRV-CA=+33.19 km/s 
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Messung der HRV der Zentralen Absorption (HRV-CA)nach  Umstellung der Wellenlängenskala auf eine 

Geschwindigkeitsskala, bezogen auf H=6562.85Å: 

 

Die heliozentrische Radialgeschwindigkeit der zentralen Absorptionseinsenkung beträgt HRV=+33.19 km/s 

Bestimmung der spektralen Auflösung anhand der Linien des Neon-Referenzspektrums:  

Mittelwert 6532Å bis 6717Å: R=6786 ± 400. FWHM = 0.97Å ± 0.01Å (Apparatebreite)  
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15. Das Langzeitmonitoring7 des Sterns zeta Tau bis 17.2.2018 (JD 58167) 
 

1. Äquivalentbreite EW der H-Linie 

2. Intensitätsverhältnis V/R der der H-Linie   

 
7 Ernst Pollmanns Auswertung des eingesandten normierten Spektrums 
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3. Intensitätsverhältnis der zentralen Absorption (CA) der H-Linie 
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16. Übertragung des Projekts an einem anderen Ort („Bundles“) 
BASS arbeitet projektbezogen. Das bedeutet, dass alle für das Projekt benötigten oder erstellten Dateien einen 

festen Pfad besitzen und in einem festen Ordner, hier C:/astrobodger/ … vorhanden sein müssen. Deshalb 

findet diese Kalibrierung von zeta Tau gemäß Tutorial ausschließlich im Ordner c:/astrobodger/zeta Tau 2018-

02-17 statt.   

Frage: Wie überträgt man die ursprüngliche Kalibrierung .bass von C:/astrobodger/ … auf eine andere 

Festplatte und/oder in einen anderen Ordner, um sie von dort aus aufrufen zu können?  

Antwort: Man öffnet wie gewohnt in c:/astrobodger zeta Tau 2018-02-17 die BASS-Datei (Beispiel: zeta Tau 

2018-02-17.bass und speichert das Projekt im neuen Ordner wie folgt als „Bundle“ ab: 

Speichern als Bundle am neuen Ort:  

➔ File 

➔ Save Project or Bundle 

➔ D:/neuer Ordner/zeta Tau 2018-02-17.bass 

 

Entpacken des Bundles am neuen Ort  

➔ File 

➔ Open Project or Bundle 

➔ D:/neuer Ordner/zeta Tau 2018-02-17.bass 

➔ Dort öffnet man die .bass-Datei des Projekts und arbeitet wie gewohnt weiter. 
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17. Kurse zur Sternspektroskopie am CFG Wuppertal 
Das Tutorials zur Kalibrierung eines Sonne-, bzw. 

Sternspektrums werden in den Kursen des Autors 

(rechts im Bild) am Carl-Fuhlrott-Gymnasium in 

Wuppertal zur Sternspektroskopie eingesetzt. Im 

Rahmen des Kurses wird u.a. das 

Tageslichtspektrum mit insgesamt sieben zur 

Verfügung stehenden DADOS-Spektrografen und 

ebenso vielen STF-8300M CCD-Kameras 

aufgenommen und für die Kalibrierung mit BASS 

vorbereitet.  

Die seit 2011 verwendete Software VisualSpec wird 

nur noch hin- und wieder herangezogen.  

Aktuelle Kursinformationen finden Sie unter:  

https://www.baader-planetarium.com/de/blog/aktuelle-spektroskopie-kurse-am-schuelerlabor-astronomie/ 
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